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PHỤ LỤC. ỨNG DỤNG 
MICROSOFT PROJECT 2003 

 
A.  QUẢN LÝ THỜI GIAN  

MỞ ĐẦU. 
Thí dụ: Công ty xây dựng A đang thầu một công trình thi công một đoạn đường với 
tổng chiều dài là 1000m. Trong đó, các hạng mục cần thi công bao gồm: khảo sát 
địa chất công trình, khảo sát các công trình ngầm đã có, lắp đặt hệ thống thoát 
nước, thi công nền móng…Từng hạng mục công việc không thể đồng thời được tiến 
hành cùng một lúc mà phải đợi một số hạng mục trước đó tiến hành xong rồi mới thi 
hành được. Vì vậy, chúng ta cần phải tạo một lịch biểu để theo dõi tiến độ thực hiện 
của từng công việc và phân bố thời gian cụ thể. 

1. Tạo lập và tổ chức một lịch biểu. 

1.1. Tạo lập một lịch biểu mới. 
Một lịch biểu dự án bao gồm danh sách các nhiệm vụ hay các hoạt động bạn 
cần làm, khoảng thời gian thực hiện các nhiệm vụ. Bước đầu tiên trong việc 
tạo một lịch biểu mới là mở Tập tin mới và gán ngày bắt đầu, ngày kết thúc 
của dự án (nếu không có ngày đầu tiên, ngày hiện tại được tự động coi như là 
ngày đầu tiên của dự án). 

1.2. Nhập các nhiệm vụ. 
1.2.1. Nhập một nhiệm vụ trong một task form: 
 

 

 

 

 

 

 
 

 

 

 

 

 

 
 

• Trên menu VIEW, nhấp More Views. 

• Trong danh sách Views, nhấp Task Form, sau đó 
nhấp Apply. 

• Trong hộp Name, nhập tên nhiệm vụ. 

• Trong hộp Duration, nhập thời hạn nhiệm vụ 

• Chọn hộp Effort driven: cho thời hạn nhiệm vụ 
không đổi bất kể sự phân công bộ phận. 

• Trong các cột form, hãy nhập thông tin chi tiết về 
nhiệm vụ (chẳng hạn như các bộ phận được 
phân phân công và các nhiệm vụ trước đây). 
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1.2.2. Nhập một nhiệm vụ trên khung xem Calendar 
 

 

 

 

 

 
 
 
 
1.2.3. Nhập một nhiệm vụ vào một dự án 

• Trên menu VIEW, nhấp Gantt Chart. 

• Trong trường Task Name, nhập một tên nhiệm vụ ở cuối danh sách nhiệm vụ. 

1.3. Chuyển một nhiệm vụ thành một cột mốc  
Cột mốc là một nhiệm vụ với độ dài=0. Khi đưa độ dài 0 cho một nhiệm vụ, 
Microsoft Project hiện ký hiệu cột mốc lên sơ đồ cột Gantt bắt đầu từ ngày đó. 
Trong phần Duration của công việc đó, bạn chọn 0d hay trên list task pane chọn 
Make Selected task milestone sau đó nhấp Done thì sẽ tạo được một cột mốc. 
Cũng có thể tạo nó từ Task Information bằng cách chọn Advance tab sau đó đánh 
dấu vào ô Make Task as Milestone. 

 
1.4. Đưa vào một nhiệm vụ lặp lại 

o Trong menu VIEW, chọn Gantt Chart. 

o Trong trường Task Name, chọn hàng ở phía dưới nơi mà muốn nhiệm vụ lặp lại. 

o Trong menu Insert, chọn Recurring Task... 

o Trong hộp Task Name, nhập tên nhiệm vụ. 

• Trên menu VIEW, nhấp Calendar. 
• Chọn ngày nhiệm vụ bắt đầu. 
• Trên menu Insert, nhấp New Task. 
• Nhấp Tab Information. 
• Trong hộp Name, nhập tên nhiệm vụ. 
• Trong hộp Duration, nhập thời hạn nhiệm 

vụ. 

CuuDuongThanCong.com https://fb.com/tailieudientucntt

http://cuuduongthancong.com?src=pdf
https://fb.com/tailieudientucntt


Phụ lục  A – Microsoft Project & Ứng dụng  

Trương Mỹ Dung 
www.fit.hcmuns.edu.vn/~tmdung 
Mail= tmdung@fit.hcmuns.edu.vn  

104

o Trong hộp Duration, nhập thời hạn của một lần xảy ra cho nhiệm vụ. 

o Trong phần Recurrence pattern, chọn Daily, Weekly, Monthly, hay Yearly. 

o Chỉ định sự thường xuyên của nhiệm vụ và chọn hộp kiểm kế bên ngày trong 
tuần mà nhiệm vụ sẽ xảy ra. 

o Trong phần Range of recurrence, nhập một ngày bắt đầu vào hộp Start, sau đó 
nhấp End after (nhập hoặc chọn số lần xảy ra cho nhiệm vụ) hay End by (hãy 
nhập hoặc chọn ngày mà muốn nhiệm vụ lặp lại kết thúc). 

 
1.5. Thay đổi độ dài một nhiệm vụ:  Trong menu, nhấp Gantt Chart, chọn  Field 

Duration, và  nhập thời hạn mới. 
1.6. Xóa bỏ một nhiệm vụ: Trong menu, nhấp Gantt Chart, Trong trường Task Name, 

chọn nhiệm vụ muốn xóa và  trong menu Edit, nhấp Delete Task. (Muốn phục một 
nhiệm vụ ngay sau khi xóa nó bằng cách nhấp Undo Delete). 

1.7.  Sắp xếp lại các nhiệm vụ trong lịch biểu. 

• Hạ mức một nhiệm vụ 

o Từ thực đơn VIEW, chọn Gantt Chart 

o Chọn nhiệm vụ bạn muốn hạ mức 

o Từ thực đơn Tools, chọn Outlining sau đó chọn Indent 

• Lên mức một nhiệm vụ 

o Từ thực đơn VIEW, chọn Gantt Chart 

o Chọn nhiệm vụ bạn muốn đưa lên một mức 

1.8. Thay đổi ngày giờ làm việc 
• Từ thực đơn Tools, chọn Change Working Time. 
• Chọn ngày trên lịch. 
• Tại Make Dates, chọn phím tuỳ chọn. 
• Nếu bạn chọn tuỳ chọn Working trong bước thứ 3, trong Working Time cần gõ 

vào thời gian bắt đầu và kết thúc làm việc. 
• Chọn phím OK. 
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2. Lập lịch cho các công việc 
KHÁI NIỆM: 

• PREDECESSOR: Một công việc cần được bắt đầu hay kết thúc trước khi một 
công việc  khác có thể bắt đầu. 

•  SUCCESOR: Một công việc phụ thuộc vào sự bắt đầu hay kết thúc của công 
việc diễn ra  trước. 

Các mối quan hệ giữa các Công việc 

FS (Finish to Start) Một Công việc bắt đầu khi Công việc trước kết thúc 

SS (Start to Start) Một Công việc bắt đầu khi  Công việc trước bắt đầu 

FF (Finish to Finish ) Một Công việc kết thúc khi Công việc trước kết thúc 

SF (Start to Finish ) Một Công việc kết thúc khi  Công việc trước bắt đầu 

2.1. Tạo lập một quan hệ giữa các công việc.  

• Từ thực đơn VIEW, chọn Gantt Chart. 

• Trong bảng Gantt, chọn hai nh.iệm vụ hay nhiều hơn mà bạn muốn nối. 

• Trong thực đơn Edit chọn LinkTask. 

2.2. Loại bỏ một quan hệ giữa các công việc.  

• Trong bảng Gantt, chọn các nhiệm vụ bạn muốn nối. 

• Trong thực đơn Edit, chọn UnLinkTask. 

2.3. Thay đổi kiểu quan hệ giữa các công việc.  

• Từ thực đơn VIEW, chọn Gantt. Chart 

• Bấm chuột đúp vào đường kết nối của các Công việc muốn thay đổi. 

• Trong hộp Type, chọn kiểu quan hệ giữa các Công việc, Chọn phím OK. 

2.4. Tiến hành song song hay trì hoãn giữa các nhiệm vụ 

• Dùng Lead Time để lập lịch một sự thực hiện chồng nhau giữa hai Công việc 
sao cho một Công việc bắt đầu trước khi Công việc của nó kết thúc. 

• Dùng Lag Time để trì hoản sự khởi đầu của một Công việc tiếp theo. 

2.5. Thêm Lead hay Lag Time 
M. Project cho phép xác lập thời gian dẫn trước (lead time, đây là khoảng thời gian 
trùng lặp giữa các nhiệm vụ lệ thuộc. Chẳng hạn, nếu một nhiệm vụ có thể bắt đầu 
khi nhiệm vụ trước của nó đã hoàn thành được một nửa, ta có thể chỉ định loại lệ 
thuộc finish-to-start với thời gian dẫn trước là 50% cho nhiệm vụ kế tiếp của nó (có 
giá trị âm)) hay thời gian trễ (lag time, đây là khoảng thời gian trì hoãn giữa các 
nhiệm vụ lệ thuộc. Chẳng hạn, nếu ta cần thời gian trì hoãn là hai ngày giữa sự kết 
thúc một nhiêm vụ và bắt đầu một nhiệm vụ khác, bạn có thể thiết lập loại lệ thuộc 
finish-to-start và chỉ định thời gian trễ là hai ngày (có giá trị dương)) giữa các nhiệm 
vụ chỉ sau khi tạo các mối quan hệ lệ thuộc giữa các nhiệm vụ. 

CuuDuongThanCong.com https://fb.com/tailieudientucntt

http://cuuduongthancong.com?src=pdf
https://fb.com/tailieudientucntt


Phụ lục  A – Microsoft Project & Ứng dụng  

Trương Mỹ Dung 
www.fit.hcmuns.edu.vn/~tmdung 
Mail= tmdung@fit.hcmuns.edu.vn  

106

 

o Trong menu VIEW, chọn Gantt Chart. 

o Trong trường Task Name, chọn nhiệm vụ muốn xác lập thời gian dẫn trước hay 
thời gian trễ cho nó, sau đó nhấp Task Information. 

o Nhấp tab Predecessors. 

 

 
 

o Trong trường Lag, nhập thời gian dẫn trước hay thời gian trễ  theo dạng một thời 
gian hay tỉ lệ phần trăm của thời hạn dành cho nhiệm vụ trước. 

o Để nhập thời gian dẫn trước, hãy nhập một số âm hay tỉ lệ phần trăm âm, chẳng 
hạn 2% đối với thời gian dẫn trước là hai ngày. 

o Để nhập thời gian trễ, hãy nhập một số dương hay tỉ lệ phần trăm dương, chẳng 
hạn như 50% cho nửa thời gian của nhiệm vụ trước trong thời gian trễ. 

2.6. Lập lịch một nhiệm vụ để bắt đầu hay kết thúc liên quan đến một ngày cụ 
thể 

• Từ thực đơn VIEW, chọn Gantt Chart. 

• Chọn nhiệm vụ bạn muốn, sau đó chọn Task Information trong thực đơn Insert. 

• Chọn Advanced tab. 

• Trong Constraint Task chọn kiểu ràng buộc từ danh sách. 

• Nếu chọn ràng buộc khác As Late As Possible hay As soon As Possible, đưa 
vào ngày trong hộp Date. Chọn phím OK. 
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B. QUẢN LÝ CHI PHÍ  
 
1. Gán chi phí cho một tài nguyên. 

o Trên Menu VIEW , chọn  Gantt Chart. 
o Trong cột Task Name, chọn tác vụ cần nhập vào chi phí một lần. 
o Trên Menu  Window, chọn Split. 
o Trong khung nhìn Task Form ở phần dưới màn hình, chọn tài nguyên ta muốn 

nhập chi phí một lần hoặc nhập vào tài nguyên mới trong cột Resource Name, 
sau đó nhấn Enter. 

o Trên trình đơn Fomat, di chuyển chuột tới Details, sau đó click Resource cost. 

 
o Trong cột Task type, click vào Fixed Duration. 
o Trong cột Units, nhập vào giá trị O và nhấn Enter. 
o Trong cột Cost, nhập vào giá trị chi phí của việc gán tài nguyên. 
o Trên trình đơn Window, click Remove Split. 

2. Chuẩn bị tính toán chi phí vượt giờ: thực hiện theo các bước sau: 

o  Trên trình đơn View, chọn khung nhìn Task Usage. 
o Trong cột Task Name, chọn tài nguyên được gán. 
o Trên trình đơn Insert, chọn Column. Trong hộp File Name, chọn Overtime 

Work và click OK 

o Trong cột Overtime work, click vào hàng của tài nguyên được gán cho tác vụ 
cần nhập vào thời gian làm việc vuợt giờ. Và trong cột này ta nhập vào thời gian 
làm việc vuợt giờ của tài nguyên được gán. Thí dụ: khi thực hiện việc lắp đặt 
công trình với một nhân công và làm việc trong 10 ngày(10x8=80 giờ), thực hiện 
các thao tác theo hướng dẫn trên, nhập  vào thời gian vượt giờ là 20 giờ thì thời 
gian hoàn thành công trình chỉ còn có 7.5 ngày vời mỗi ngày làm thêm 2 giờ 
(10x2=20 giờ) 
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o Tương tự cho các tài nguyên khác. 

Thời gian vuợt giờ khi nhập vào là  một phần của tổng thời gian làm việc mà ta 
đã nhập vào trong phần tài nguyên, do đó khi nhập vào thời gian làm việc sẽ 
được rút ngắn. 

 

3. Tìm kiếm các chi phí vượt ngân sách  
3.1. Xem các tác vụ có chi phí vượt quá ngân sách. 

o Trên menu view,  nhấp Task Usage, trỏ đến Table, sau đó nhấp Cost  
o Trong hộp Filter, nhấp Cost Overbudget   
o Xem các chi phí vượt quá ngân sách, nhấp Cost Greater than trong hộp Filter, 

sau đó xác định giá trị phí tổn trong hộp Show tasks/assignments whose cost 
is greater than.  

o Để xem tất cả các tác vụ, nhấp All Tasks trong hộp Filter. 
3.2. Các tác vụ và tài nguyên có chi phí vượt ngân sách   

o Trên menu View, nhấp Reports.  
o Nhấp Costs, sau đó nhấp Select. 
o để hiển thị các tác vụ vượt quá ngân sách, nhấp Overbudget Tasks, sau đó 

nhấp select. Để hiển thị các tài nguyên vượt quá ngân sách, nhấp Overbudget 
Resources, sau đó nhấp select. 

4.   Gán chi phí cố định cho một nhiệm vụ: 

o Trên trình đơn View, chọn khung nhìn Gantt Chart. 
o Trên trình đơn View, di chuyển chuột tới Table, sau đó click Cost. 
o Trong cột Task Name, chọn tác vụ ta muốn nhập vào chi phí cố định. 
o Trong cột Fixed Cost, nhập vào giá trị chi phí. 

Lưu ý: Nếu muốn nhập vào chi phí cố định cho toàn bộ dự án, ta thực hiện như sau: 

Click chọn Option trên trình đơn Tools, click vào hộp View. Trong phần Outline 
options, đánh dấu chọn Project summary task và click OK. Trong cột Task Name 
sẽ xuât hiện tên dự án (ở hàng đấu tiên có số thứ tụ là 0), nhập chi phí cố định của 
toàn bộ dự án ở hàng này trong cột Fixed Cost. Ví dụ:  
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5. Kiểm soát sự gia tăng chi phí của dự án. 
Sau khi gán mức giá cho các tài nguyên hoặc chi phí cố định cho các tác vụ, có thể 
cần quan sát tổng các chi phí này để phục vụ cho việc quản lý tài chính, điều chỉnh 
tác vụ v.v.. 

5.1. Quan sát chi phí của một tác vụ.  Trên trình đơn View, click More View, chọn 
Task Sheet và click Apply. Trên trình đơn View, di chuyển chuột đến Table, chọn 
Cost. 

5.2. Quan sát chi phí của một  tài nguyên Trên trình đơn View, chọn Resource 
Sheet. Trên trình đơn View, di chuyển chuột đến Table, chọn Cost. 
Lưu ý:  Chúng ta có thể quan sát việc phân phối chi phí cho tác vụ trong khung nhìn 
Task Usage bằng cách cho hiển thị chi tiết về chi phí. Cách làm quen thuộc là vào 
trình đơn View, chọn khung nhìn Task Usage. Trên trình đơn Format, di chuyển 
chuột tới Details, chọn Cost.  Cách làm tuơng tự cho việc quan sát chi phí về tài 
nguyên. Và với riêng tài nguyên, ngoài việc quan sát trong khung nhìn Task Usage, 
ta còn có thể quan sát sự phân phối chi phí này theo dạng biểu đồ (chọn lựa trong 
Detail của trình đơn Format dạng quan sát chi phí phân bổ theo thời gian Cost 
hoặc quan sát chi phí tích lũy theo thời gian Cummulative Cost). 

5.3.  Quan sát chi phí của toàn bộ dự án 
o Trên trình đơn Project, chọn Project Information. 
o Khung nhìn Project Information xuất hiện, chọn Statistics. 
o Trong hàm current, ở cột Cost ta có thể quan sát được tổng chi phí theo kế 

hoạch của dự án.  
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6. Lưu các thông tin về chi phí bằng một kế hoạch cơ sở 
6.1. Tạo một kế hoạch cơ sở 

Sau khi lập kế hoạch cho một dự án, trong quá trình triển khai thực hiện dự án có 
thể có nhiều thay đổi hoặc cũng có thể phải tìm một giải pháp mới. Vấn đề đặt ra 
làm sao biết được kế hoạch sau khi được điều chỉnh hoặc lập mới có ưu điểm gì 
không như về thời gian, chi phí , nhân lực … 

Microsoft Project cung cấp cho ta một công cụ để làm được điều này là bằng cách 
lưu kế hoạch ban đầu lại dưới dạng một kế hoạch cơ sở (Baseline plan) hoặc kế 
hoạch tạm thời (Interim plan), sau đó ta cứ việc điều chỉnh kế hoạch, các kết quả 
của kế hoạch mới được lập sẽ được so sánh trực tiếp với các kết quả của kế 
hoạch cơ sở. Ta có thể làm theo các bước như sau: 

o Trên Menu View, chọn Gantt Chart. 
o Trong cột Task Name, đánh dấu chọn các công tàc ta cần lưu thông tin cơ sở 

(nếu chỉ muốn lưu thông tin cơ sở cho một sồ tác vụ). 

o Trên Menu Tools, di chuyển chuột tới Tracking, chọn Save Baseline. 

 

6.2. Sao chép một kế hoạch cơ sở. Trong trường hợp muốn sao chép một Baseline 
theo một Baseline đã tạo trước, cũng tương tự trên Menu Tools, Chọn 
Tracking, chọn Save Baseline. 

 
6.3.  Xóa một kế hoạch cơ sở. Trong trường hợp muốn xoá một hay nhiều kế 

hoạch cơ sở, thực hiện như sau: 

o Trên Menu Tools, chọn  Tracking, sau đó chọn Clear Baseline. 

o Để xoá một Baseline, chọn Clear Baseline plan, chọn tên của kế hoạch cơ 
sở muốn xoá. 

o Chọn Entire project hoặc Selected tasks để xoá toàn bộ kế hoạch hay một 
phần theo các tác vụ được đánh dấu. 
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7. Thay đổi phương thức tính toán phí thực tế (Actual Cost) 

Trong quá trình dự án được thực hiện, chi phí thực tế cho các tác vụ bắt đầu xuất 
hiện song song với quá trình thực hiện và được Microsoft Project tính toán tự động 
khi cập nhật quá trình thực hiện các tác vụ, tuy nhiên trong thực tế chi phí này có thể 
không như tính toán và ta sẽ nhập vào bằng tay để thuận tiện cho việc quản lý dự 
án. Để chương trình không tự động tính toán chi phí thực tế ta làm như sau: 

o Trên Menu Tools  Options  Calculation. 

o Để nhập giá trị chi phí bằng tay, ta xoá đi dấu Actual costs are always 
calculated by Microsoft Project và ngược lại khi muốn Microsoft Project tự 
động tính toán giá trị này. 

o Click OK. 
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C. QUẢN LÝ TÀI NGUYÊN  

 

1. Lập danh mục các tài nguyên của dự án. 
1.1. Tạo danh mục tài nguyên sử dụng cửa sổ Resource Sheet 

1.2. Ý nghĩa các trường trong Resource Sheet 

1.3. Định nghĩa bảng tài nguyên của dự án 

 

2. Điều chỉnh thông tin của tài nguyên 
2.1.  Gán phương thức truyền thông cho tài nguyên (Assigning a communication 

method) 
2.2.  Xác định tính hiệu lực của tài nguyên (Specifying resource availability) 
2.3.  Xác định loại Booking (Specifying a Booking type) 
2.4.  Tạo một chủng loại tài nguyên (Creating a generic resource) 
2.5.  Thêm chú thích cho tài nguyên 
2.6.  Tạo lịch cho tài nguyên 
 
3. Phân bổ tài nguyên 
3.1. Phân bổ tài nguyên cho một công việc. 

Ta có thể phân bổ tài nguyên cho công việc bằng cách choïn View  Gantt Chart 
thanh,và tiếp tục thực hiện các bước sau nếu phân bổ tài nguyên cho công việc: 
o Lựa chọn một công việc mà ta muốn phân bổ tài nguyên : click vào thanh công 

việc trên Gantt Chart, hoặc click vào một vài cột trong Gantt Chart. 
o Click vào Assign Resources hoặc Lựa chọn Tool  Assign Resources để mở 

hộp thoại Assign Resources , như trình bày trong hình sau : 
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o Lựa chọn tài nguyên muốn phân bổ từ danh sách Resource Name của hộp thoại 
Assign Resources. 

 

o Click Assign. Project đặt một check đánh dấu trong cột cực tả của hộp thoại  
Assign Resources cho biết việc lựa chọn  công việc.   

o Lặp lại bước  trên  để  phân bổ thêm tài nguyên vào việc lựa chọn  công việc 
hoặc click Close. 

 
3.2. Sử dụng trợ giúp khi chọn tài nguyên   
3.3. Thay đổi tài nguyên  của một công việc  

Xóa  một tài nguyên được phân bổ : chọn công việc có phân bổ tài nguyên muốn 
xóa,  click vào nút Assign Resources hoặc chọn Tools Resource Assign 
Resources  trong hộp thoại Assign Resources. Làm cho nổi bật tài nguyên để xóa từ 
công việc. Ta có thể xem một checkmark next tài nguyên trong cột cực tả của hộp 
thoại  Click Remove, như trình bày trong hình sau :  

 

 
 
 

o Dùng chức năng  Replace để thay thế  tài nguyên. 
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4. Giải quyết vấn đề xung đột tài nguyên. 
Khi ta chỉ định các tài nguyên cho các nhiệm vụ, M. Project kiểm tra lịch biểu của các 
tài nguyên để xác định tài nguyên đang làm việc. Tuy nhiên, M.Project không truy 
cập được một khi tài nguyên đã được sử dụng và bạn lại gán thêm một nhiệm vụ 
mới. Thí dụ,  nếu ta chỉ định Tuấn làm việc quá thời gian trong hai nhiệm vụ và thời 
điểm bắt đầu giống nhau, thực chất bạn chỉ định Tuấn làm việc 16 giờ thay vì 8 giờ 
trên ngày - điều này Tuấn không làm được cho dù là một công nhân tận tâm làm 
việc.  

 
4.1. Phát hiện các tài nguyên xung đột. 
4.1.1. Sử dụng Views để phát hiện xung đột. 

Sử dụng Resource Sheet hay view Resource Usage, để tìm các tài nguyên xung đột. 
Trong view này, các tài nguyên tranh chấp xuất hiện với màu đỏ. Thêm vào đó, một 
biểu tượng quan trọng xuất hiện trong cột Indicator tới một tài nguyên bị gán chồng.  
Để hiển thị view Tài nguyên sử dụng xem trong hình sau: chọn View -> Resource 
Usage. 

 
  

Ta cũng có thể xem sự chanh chấp qua biểu đồ bằng cách click trên menu vào view-
>Resource Graph. 

 
 

Xem xét việc tranh chấp các tài nguyên sẽ hữu ích cho làm việc với các tranh chấp - 
Biểu đồ Gantt  Chart trong khung dưới chỉ ra các nhiệm vụ được chỉ định tới các tài 
nguyên mà bạn chọn trong khung trên. Các nhiệm vụ mà được bắt đầu tại một thời 
điểm sẽ chồng lên nhau trong khung Gantt Chart. Điều này giúp ta xác định các vấn 
đề mà chính chúng gây ra tranh chấp tài nguyên. 
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Trên biểu đồ Gantt Chart trên chỉ cho ta thấy tài nguyên Máy Tính bị tranh chấp. 
 

4.1.2. Sử dụng Filters để phát hiện xung đột. 
Một kỹ thuật đơn giản khác mà ta có thể dùng để phát hiện và giải quyết các vấn đề 

xung đột tài nguyên là dùng Filters: sử dụng chức năng  Project->Filtered   -
>Overallocated Resource. 

 

 
 
 
Tiếp đó để mô tả kỹ hơn các tài nguyên bị xung đột ta vào Format->Details   -

>Overallocation. 
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Ở dòng work là số giờ phải làm trong ngày, dòng Overal là số giờ làm quá quy 

định. 
 
 

4.2. Giải quyết các xung đột. 
 

4.3.1 Lên lịch thời gian làm thêm (Scheduling overtime).  
Có thể giải quyết xung đột tài nguyên bằng cách lên lại lịch cho tài nguyên. Overtime 
trong project là một lượng công việc cái được xếp trễ hơn so với kế hoạch làm việc 
bình thường, và các giời overtime được thay đổi theo tỉ lệ overtime của tài nguyên. 
Công việc overtime không được hiển thị thêm trong tác vụ. Thay vào đó, nó hiển thị 
một thời gian đã hao phi dựa trên một tác vụ trong suốt các giời không chính quy. 
Bằng việc xác định lịch, tài nguyên có thể hoàn tất tác vụ nhanh hơn và do đó ta có 
thể loại được các xung đột.  Để  lên lịch thời gian làm thêm ta tiến hành các bước 
sau: 
1. View -> Gantt Chart. 
2. Window -> Split. 
3.  Nhấp vào khung dưới. 
4. Format -> Details -> Resource Work. 
5. Click nhiệm vụ cần overtime. 
6. Điều chỉnh lại lượng thời gian thích hợp.  
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4.3.2 Xác định lại lịch cho tài nguyên. 

Nếu một tài nguyên có xung đột và số giờ xung đột trong một ngày được cho là 
chưa đủ, bạn có thể loại ra bằng cách tăng số giờ làm việc cho tài nguyên trong 
ngày đó. Để thay đổi lịch làm việc cho tài nguyên, tới Resource Usage view. Xác 
định tài nguyên nơi có tranh chấp, và ghi chú số giờ tranh chấp. Nhấp đúp chuột vào 
tài nguyên tranh chấp mở hộp thoại Resource Information cho tài nguyên đó. Nhấp 
vào tab Working Time tới xem lịch tài nguyên đó, như hình sau: 

 

 
 

Để thay đổi giờ làm việc chuẩn cho tài nguyên ta làm các bước sau: 
1. Click ngày đầu tiên của tài nguyên bị tranh chấp. 
2. Nhấn chọn Use default. 
3. Sử dụng From và To để cài đặt các giờ làm không chuẩn cho các ngày đó. 
4. Lập lại quá trình trên cho mỗi ngày mà bạn muốn thay đổi lịch biểu làm việc cho 

một tài nguyên đặc biệt. 
5. Click vào OK khi bạn hoàn thành. 

 
4.3.3 Bổ sung công việc bán phần. 

Giả sử một tài nguyên được bổ sung tới một số nhiệm vụ hiện tại và cũng bị tranh 
chấp. Cũng giả sử là ta không muốn thêm một tài nguyên nào nữa, hay chuyển đổi 
giữa các tài nguyên, thêm giờ làm. Ta có thể bổ sung tài nguyên vào công việc bán 
phần cho mỗi tác vụ để giải quyết tranh chấp, thông qua các tác vụ có thể dẫn đến 
lâu hơn để hoàn thành bằng cách sử dụng phương pháp này. Để bổ sung công việc 
bán phần, bạn có thể phải sắp xếp lại tài nguyên để tiện cho việc thêm tác vụ. Mặc 
định M. Project cài đặt kiểu tác vụ để Fixed Units. Để thay đổi loại tác vụ tới Fixed 
Duration, thực hiện theo các bước sau: 
1. View ➪  More Views ➪  Resource Allocation. 
2. Click vào tác vụ khung trên. 
3. Double Click vào tác vụ mà bạn muốn thay đổi ở khung dưới. 
4. Mở combobox Task type ➪  Fixed Duration. 
5. Click OK. 
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Tiếp theo, ta có thể chỉ định tài nguyên để làm bán thời gian vào tác vụ này mà 
không thay đổi khoảng thời gian của tài nguyên: 

1. Vào Resource Allocation, click vào tác vụ khung trên nơi mà ta xác định là tài 
nguyên bị tranh chấp 

2. Click vào nút Assignment Information trên thanh Standard, hay click hai cái để 
mởi hộp thoại Assignment Information. Chọn tab General. 

3. Thay đổi giá trị mặc định trong hộp Units (100%) theo tỉ lệ phần trăm thời gian 
mà bạn muốn tài nguyên làm tác vụ đó.  Click OK. 

 

 
 
 

4.3.4 Kiểm soát khi tài nguyên bắt đầu trên một công việc (Controlling when 
resources start working on a task). 

Để nhân lên thời gian cho các tài nguyên, công việc trong Task Usage view và theo 
các bước sau:  

1. View ➪  Task Usage. 
2. Chọn tài nguyên nơi bạn muốn hoãn thời gian trong cột Task Name. 
3. Double click vào tài nguyên. Hộp thoại Assignment Information. 
4. Thay đổi này tại ô Start hay Finish. 
5. OK. 
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4.3.5 Trì hoãn công việc bằng cách phân mức tài nguyên (Delaying tasks by 

leveling resource workloads). 
Việc phân mức tài nguyên là quá trình xử lý đụng độ tài nguyên bằng cách trì hoãn 
hay phân nhóm các công việc để cung cấp kế hoạch của chỉ định các tài nguyên.  
o Tự động phân mức (Automatic leveling) theo thứ tự ưu tiên: 

Để thực hiện priority cho các tác vụ ta thực hiện các bước sau: 

1. View ➪  Gantt Chart. 

2. Double Click vào tác vụ muốn priority. 

3. Chọn tab General tại ô Priority ta điều chỉnh theo ý muốn. 

 

Để các phân mức các tác vụ tự động ta thực hiện các bước: 

1. Tools ➪  Level Resource. 

2. Chọn nút Automatic. 

3. Để xác định priority cụ thể hơn (theo ngày, giờ,…) ta chọn trong danh sách 
Look for overllocation on a… 

4. Chọn Clear leveling project sẽ reset tất cả các phân mức về 0 trước khi phân 
mức. Nếu bạn không đánh dấu tuỳ chọn này thì project sẽ không trả về giá trị 
0. 

5. Trong khung Leveling range for, chọn level entire project để phân mức cho 
toàn bộ project. Còn chọn level là chỉ phân mức cho từ ngày nào tới ngày 
nào mà thôi. 

6. Trong danh sách Leveling order nếu chọn: 

o ID: project sẽ trì hoãn hay phân nhóm tác vụ có số ID cao nhất. 

o Standard: project sẽ tìm tác vụ tốt nhất để phân nhóm hay trì hoãn. 

o Priority, Standard: project sẽ chọn tại các quyền ưu tiên tác vụ và sau đó 
là tất cả các mục mà được liệt kêt cho cấp độ phân mức Standard. 
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7. Chọn một trong các tuỳ chọn trong khung Resolve overallocations: 

o Level only within available slack: tránh thay đổi ngày kết thúc project của 
bạn. 

o Leveling can adjust individual assignments on a task: chỉ phân mức kế 
hoạch của tài nguyên dựa trên tác vụ độc lập của các tài nguyên khác mà 
nó đang làm việc trên tác vụ tương tự. 

o Level can create splits in remaining work: cho phép phân nhóm các tác 
vụ để giải quyết các mâu thuẫn tài nguyên. 

o Level resource with the proposed booking type: kiểm tra hộp thoại này có 
trong các tác vụ Project trong suốt quá trình phân mức. 

8. Click vào Level Now để chấp nhận các phân mức trên: 

 

Bạn có thể xem các thay đổi của việc phân mức bằng cách vào: View ➪  More 

Views ➪  Level Gantt ➪  Apply. 
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o Điều khiển việc phân mức: Ta làm việc này tuần tự qua các bước sau:  

1. View ➪  More Views. Đưa vệt sáng vào Resource Allocation và click Apply. 

2. Đưa vệt sáng vào nơi mà bạn muốn trì hoãn ở khung trên. 

3. Trong khung dưới, nhập vào số ngày trì hoãn vào cột  Leveling Delay. 

 

 
4.3.6 Đánh dấu tài nguyên (Contouring resources). 

 
Đánh dấu là một mục mà M. Project sử dụng để chỉ dẫn việc sắp xếp các nhiệm vụ 
các công việc của tài nguyên quá thời gian. Phổ biến nhất là Flat, Back Loaded, 
Front Loaded, và Bell. Mặc định là Flat, có nghĩa là tài nguyên làm việc trên một tác 
vụ cho số giờ lớn nhất mà ta chỉ định với một khoảng thời gian. Ta có thể sử dụng 
các đánh dấu khác nhau để điều khiển một tài nguyên được lên lịch trình như thế 
nào làm việc trên một tác vụ vào một thời gian – và khi làm điều này ta có thể giải 
quyết tranh chấp.   Các đánh dấu giúp bạn chỉ định công việc cho một tác vụ dựa 
trên các yếu tố mà tác vụ đòi hỏi. Ví dụ, nếu một tác vụ đòi hỏi ít ban đầu, ta sử 
dụng chế độ đánh dấu Back Loaded. Nếu một tác đòi hỏi cao hơn ta sử dụng chế độ 
Bell, Turtle, hay Early Peak. 
 
Cài đặt một đánh dấu mẫu (Setting a contour pattern): 
o View ➪  Task Usage.  
o Double click tài nguyên muốn đánh dấu.  
o Mở list box Work countour và chọn chế độ đánh dấu. 
o OK. 
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5. Chia sẻ tài nguyên giữa các Project. 
5.1. Tạo một tài nguyên chung và chia sẽ các tài nguyên. 

Tạo một tài nguyên chung trong một Project để có thể dễ dàng quản lý tài nguyên, 
đặc biệt cho các tài nguyên muốn chia sẽ cho nhiều đề tài. Để tạo ra một tài nguyên 
chung ta tiến hành các bước sau: 

1. Mở các project mà ta muốn đưa vào tài nguyên chung. 
2. Vào View->Resource Sheet cho mỗi project đó. 
3. Mở một Project mới, sau đó lưu lại (ví dụ: resource pool). 
4. Mở các project có tài nguyên muốn chia sẻ chọn Tools->Resource 

Sharing->Share Resource. 
5. Chọn Use resource.  
6. Từ hộp From chọn resource pool (tên tài nguyên chung ta mới lưu bước 

3) 
 

 
 
7. Trong panel On conflict with calendar or resource information, nếu bạn 

chọn pool takes precedence khi có xung đột xảy ra thì chương trình sẽ 
lấy bên tài nguyên chung để viết các thông tin chồng lên tài nguyên được 
chia sẻ. Nếu bạn chọn dưới thì ngược lại. 

8. Click OK. 
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5.2. Mở một project có sử dụng tài nguyên chung. 
 
Để mở một project có sử dụng tài nguyên chung bạn double click vào project đó, 

trong hộp thoại Open Resource Pool Information  
 

 
 

o Mở tập tin riêng :Do not open other files, project chỉ mở tập tin của bạn.  
o Lưu ý: Khi chọn  Mở tập tin chung (Option đầu trong hộp thoại Open Resource 

Pool Information),  M.Project tự động mở tập tin tài nguyên chung theo chế độ 
read-only. Do đó một lúc có thể có nhiều người có thể sử dụng tài nguyên chung 
cùng một lúc. 
 

5.3. Hủy bỏ việc chia sẻ tài nguyên giữa các dự án. Thực hiện theo từng bước 
sau: 
1. Chọn Tool Resource Sharing->Share Resource. 
2. Chọn Use own Resource trong hộp thoại. 

 

 
 
 

Tuy nhiên, cũng không cần phải mở từng tập tin và huỷ bỏ chia sẻ tài nguyên không, 
ta có thể  làm theo các bước sau: 
1. Mở tập tin tài nguyên chung ở chế độ read-write bằng cách sử dụng hộp thoại 

Open. Project sẽ hiển thị hộp thoại  Open Resource Pool sau: 
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Chọn option ở giữa hay cuối trong hộp thoại. Cả hai tuỳ chọn này đều huỷ bỏ chia sẽ 
tài nguyên chung. 
 
2. Chọn Tools->Resource Sharing->Share Resource. Project hiển thị hộp thoại 

Share Resource như sau: 
 

 

 
 

 
3. Chọn project mà bạn muốn loại ra từ tài nguyên chung. Bạn có thể chọn nhiều 

tài nguyên bằng cách nhấn và giữ Ctrl hay Shift khi bạn click chuột. 
 
4. Click Break Link. 
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